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MOTTO 

 

 Barang siapa yang bersungguh-sungguh ia akan dapat yang ia inginkan. 

 

 Tidak ada kamus tidak bisa, tetapi yang ada belum bias. 

 

 Jadilah orang yang kakinya menapakkan di tanah tetapi cita-citanya setinggi 

bintang. 

 

 Jangan mengulang kesalahan yang sama, dan jadikan hari ini lebih baik dari hari 

kemarin. 

 

 Kegagalan itu biasa, tetapi kesuksesan adalah luar biasa. 
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PERSEMBAHAN 
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Sesungguhnya apa yang ditetapkan tidak  mengenaimu pasti tidak akan menimpamu, sebaliknya apa 

saja yang ditetapkan meimpamu, kamu pasti tidak akan dapat menghindarinya. 

Sesungguhnya pertolongan itu datangnya bersama kesabaran, 

kesenangan bersama kesusahan dan sesungguhnya 

beserta kesulitan adalah kemudahan. 

(HR. Muttafaq’alaih) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Teruntuk : 

Kedua Orang Tuaku 

Atas kasih sayang, cinta dan pengorbanan dalam hidupku 

Adik-adikku yang selalu hadir untukku 

Teman-teman yang terus membantuku   

Almamaterku 

 



vi 

 

THE FINAL PROJECT 

THE MAKING OF ANIMATION OF AUTOMATIC TRANSMISSION 

SYSTEM 

 

Indra Wahyu Perdana 

I 8606012 

 

ABSTRACT 

 

The main purpose of this study is to build an animation of the working principle of the 

automatic transmission for automotive application. The animation contains the explanation 

of each component of the automatic transmission, the working principle of each section 

and the working principle of the whole system. Several softwares are employed to integrate 

all data in constructing the aniation such as Vector Works 11, Autocad 2006, 3DS Max 9, 

Corel Rave 3, Photoshop CS2, Cool Record Edit Pro 5.4 and movie edit pro 14.  

Building the animation begins from the planetary gear mechanism using 3dsmax 9, 

followed by development of the hydraulic control system animation using Corel rave 3. 

The results are then joined with the auxiliary data such as the partial section of the 

automatic transmission pictures and naration audio as the animation video description. 

Movie Edit pro 14 is used to perform this stage.  

As the results, the animation can be used as a reference in order to easy understand the 

student in studying the working principle of the automotive automatic for automotive 

application. 
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TUGAS AKHIR PEMBUATAN ANIMASI  

SISTEM TRANSMISI OTOMATIS 

 

Indra Wahyu Perdana 

I 8606012 

 

ABSTRAK 

 

Tujuan dari Tugas Akhir ini adalah pembuatan animasi tentang cara kerja sistem 

transmisi otomatis pada mobil. Animasi ini menjelaskan bagian-bagian penyusun dari 

sistem transmisi otomatis, cara kerja setiap bagian dan cara kerja keseluruhan sistem yang 

terdapat pada transmisi otomatis. Dalam pembuatan animasi software yang digunakan 

adalah Vector Works 11, AutoCAD 2006, 3DS Max 9, Corel RAVE 3, Photoshop CS2, 

Cool Record Edit Pro 5.4, Movie Edit Pro 14 digunakan dalam penggabungan keseluruhan 

data. 

Pembuatan animasi dimulai dari animasi planetary gear unit dengan software 3DS 

Max 9, dilanjutkan pembuatan animasi hydraulic control system dengan software Corel 

RAVE 3, kemudian digabungkan dengan data-data lain seperti foto-foto bagian transmisi 

otomatis dan audio narasi sebagai penjelasan pada video animasi ini. Penggabungan 

dilakukan dengan software Movie Edit Pro 14. 

Animasi ini dapat dijadikan sebagai referensi agar lebih mudah dalam mempelajari cara 

kerja sistem transmisi otomatis pada mobil. 
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BAB I 

PENDAHULUAN 

 

1.1 Latar Belakang 

Selaras dengan semakin berkembangnya zaman dan semakin bertambahnya kebutuhan 

manusia akan mobilitas yang semakin tinggi menjadi alasan yang tepat guna 

mengembangkan penemuan-penemuan dibidang transportasi yang lebih handal, baik dalam 

hal keamanan, efisiensi, serta kemudahan tanpa mengesampingkan kenyamanan dalam 

penggunaannya. 

Kendaraan sebagai sarana transportasi yang paling efektif saat ini dituntut memiliki 

karakteristik nilai jual yang handal, kuat dan tangguh. Kendaraan dalam hal ini adalah 

yang menggunakan sistem transmisi otomatis, bila menggunakan sistem transmisi otomatis 

tidak perlu menginjak pedal kopling dan tidak perlu memindahkan gigi kecepatan secara 

manual karena pada sistem transmisi ini perpindahan gigi kecepatan sudah teratur secara 

otomatis. Sistem transmisi otomatis tersusun dari Torque Converter, Planetary Gear Unit, 

dan Hydraulic Control System. Semua sistem tersebut harus dapat bekerja dengan baik 

agar didapatkan kinerja sistem transmisi otomatis yang handal dan bagus. 

Dalam Tugas Akhir ini akan dibuat Animasi Sistem Transmisi Otomatis dengan 

memperlihatkan komponen-komponen apa saja yang ada dalam sistem transmisi otomatis 

tersebut. Sehingga hasil dari pembuatan animasi ini dapat memperlihatkan bagaimana 

mekanisme kerja dari komponen-komponen yang ada dalam sistem transmisi otomatis. 

Pembuatan animasi ini dilatarbelakangi dengan sangat minimnya referensi berupa buku 

atau visualisasi berupa video animasi tentang transmisi otomatis dibandingkan dengan 

referensi untuk transmisi manual yang sudah cukup banyak, seperti kita ketahui dalam 

dunia otomotif dikenal ada 3 jenis transmisi, yaitu : transmisi manual, transmisi otomatis 

dan transmisi semi otomatis. 

Dari Tugas Akhir yakni Pembuatan Animasi Sistem Transmisi Otomatis ini dapat 

dihasilkan visualisasi sistem transmisi otomatis yang mudah dipahami dan dengan hasil 

yang optimal sehingga dapat bermanfaat sebagai acuan pengembangan teknologi yang 

lebih maju dengan memahami mekanisme kerja sistem transmisi otomatis. 
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1.2 Perumusan Masalah 

Dalam Tugas Akhir ini masalah dapat dirumuskan sebagai berikut : 

Bagaimana membuat animasi cara kerja Sistem Transmisi Otomatis mobil? 

 

1.3 Pembatasan Masalah 

Studi kasus  sebagai batasan masalah dalam Tugas Akhir ini : 

a. Animasi yang dibuat adalah untuk menjelaskan bagaimana cara kerja Sistem 

Transmisi Otomatis mobil yang menggunakan sistem planetary gear unit. 

1. Animasi 3D bagian Planetary Gear Unit untuk kecepatan 1, 2, 3 dan R dalam 

posisi tuas pemindah Drive (D), Reverse (R), Manual Second (2), dan Manual 

Low (L) dengan menggunakan program 3DS Max 9. 

2. Animasi 2D bagian Hidraulic Control System untuk kecepatan 1, 2, 3 dan R 

dalam posisi tuas pemindah Drive (D), Reverse (R), Manual Second (2), dan 

Manual Low (L) dengan menggunakan program Corel RAVE 3. 

b. Software yang digunakan : 

1. Vector Works 11 

2. Auto CAD 2006 

3. 3D Studio Max 9 

4. Corel RAVE 3 

5. Photoshop CS2 

6. Cool Record Edit Pro 5.4 

7. Movie Edit Pro 14 

 

1.4 Tujuan dan Manfaat 

a. Tujuan 

Membuat animasi cara kerja Sistem Transmisi Otomatis mobil. 

b. Manfaat 

1. Secara Teoritis 

Dapat memperoleh pengetahuan tentang sistem transmisi otomatis, desain CAD 

dan pembuatan animasi. 
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2. Secara Praktis 

Mengetahui karakteristik setiap komponen yang digunakan beserta cara 

kerjanya, terutama pada sistem Planetary Gear Unit. Hasil dari tugas akhir ini 

dapat dimanfaatkan oleh mahasiswa lain untuk dijadikan bahan belajar ataupun 

sebagai bahan referensi agar lebih mudah memahami sistem transmisi otomatis. 

 

1.5 Metodologi Penyusunan Tugas Akhir 

Sistematika dalam penyusunan Tugas Akhir Pembuatan Animasi Sistem Transmisi 

Otomatis ini adalah : 

a. Mencari referensi berupa buku, foto, gambar atau data melalui internet yang 

berhubungan dengan sistem transmisi otomatis 3 kecepatan. 

b. Mengajukan Proposal Perencanaan Tugas Akhir ke dosen pembimbing I dan dosen 

pembimbing II. 

c. Menggambar dasar 2D bagian Planetary Gear Unit dengan menggunakan software 

Vector Works 11 yang dilanjutkan pada software Auto CAD 2006. 

d. Mengubah gambar 2D bagian Planetary Gear Unit menjadi 3D dengan 

menggunakan software Auto CAD 2006. 

e. Meng-import gambar 3D dari Auto CAD 2006 kemudian menganimasikan sesuai 

cara kerja Planetary Gear Unit sistem transmisi otomatis 3 kecepatan dan me-

render dalam bentuk video (AVI). 

f. Membuat animasi Hydraulic Control System dengan menggunakan software Corel 

RAVE 3, dan me-render dalam bentuk video (AVI). 

g. Membuat narasi dalam bentuk audio (Wave) yang menjelaskan tentang operasi 

dasar Sistem Transmisi Otomatis 3 kecepatan dengan menggunakan software Cool 

Record Edit Pro 5.4. 

h. Menggabungkan video (AVI), audio narasi (Wave) yang telah dibuat beserta foto-

foto sistem transmisi otomatis dengan menggunakan software Movie Edit Pro 14. 

i. Membuat laporan tertulis berupa Laporan Tugas Akhir Pembuatan Animasi Sistem 

Transmisi Otomatis berdasarkan data-data yang telah dihimpun pada saat 

pengerjaan Tugas Akhir. 

 

 



xiv 

 

1.6 Sistematika Penulisan 

Sistematika penulisan dalam penyusunan Tugas Akhir ini adalah sebagai berikut : 

BAB I. PENDAHULUAN 

Pada bagian ini penulis menyajikan tentang latar belakang, perumusan masalah, serta 

maksud dan tujuan dalam  pengerjaan Tugas Akhir ini. 

BAB II. DASAR TEORI 

Membahas tentang bagaimana prinsip dasar dan komponen-komponen transmisi 

otomatis. 

BAB III. PEMBUATAN ANIMASI SISTEM TRANSMISI OTOMATIS 

Membahas dan menjelaskan tentang perancangan dan pembuatan Animasi Transmisi 

Otomatis mobil 3 kecepatan. 

BAB IV. HASIL PEMBUATAN ANIMASI 

Menjelaskan tentang Animasi Sistem Transmisi Otomatis mobil 3 kecepatan yang telah 

dibuat. 

BAB V. PENUTUP 

Berisi kesimpulan dan saran dari analisis hasil kerja Animasi Sistem Transmisi 

Otomatis. 

DAFTAR PUSTAKA 

LAMPIRAN 
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BAB II 

DASAR TEORI 

 

2.1 Transmisi Otomatis (Automatic Transmission) 

Pada kendaraan bertransmisi otomatis tidak dijumpai pedal kopling, perpindahan ke 

gigi yang lebih tinggi atau yang lebih rendah dilakukan secara otomatis, sesuai dengan 

besarnya penekanan pada pedal akselerator dan kecepatan kendaraan. 

Transmisi otomatis pada dasarnya dibagi menjadi 2 macam, yaitu : 

a. Transmisi otomatis penggerak roda belakang. 

 

Gambar 2.1. Transmisi otomatis penggerak roda belakang. 

(http://public.fotki.com/wackydave/car_related_reference/manufacturers-media-

pics/gm_media_pics/x06pt_at005.html) 

 

b. Transmisi otomatis penggerak roda depan. 

 

Gambar 2.2. Transmisi otomatis penggerak roda depan. 

(http://www.autotrends.org/technology/transmissions/) 

 

Kedua transmisi ini terlihat berbeda tetapi cara kerjanya sama, keduanya mempunyai 

disain rangkaian roda gigi planet (planetary gear train) yang digunakan dalam semua 

transmisi otomatis. 
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Sebuah transmisi otomatis terdiri dari 3 bagian utama yang masing-masing mempunyai 

fungsi khusus tersendiri. 

 

Gambar 2.3. Bagian-bagian utama pada transmisi otomatis. 

(http://martin1948.blogspot.com/2007_11_05_archive.html) 

  

a. Torsi Konverter (Torque Converter) 

Torsi konverter berfungsi sebagai pengubah tenaga putar yang dihasilkan oleh 

mesin yang selanjutnya disalurkan  ke unit roda gigi planet (planetary gear unit). 

Torsi konverter juga bertindak sebagai kopling otomatis sehingga mesin diijinkan 

untuk idle ketika kendaraan berhenti atau pada saat putaran mesin rendah. 

   

Gambar 2.4. Torsi konverter. 

(http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm) 

 

b. Unit Roda Gigi Planet (Planetary Gear Unit) 

Unit roda gigi planet berfungsi sebagai penerima input dari torsi konverter dan 

pengubah kecepatan serta tenaga putar sesuai dengan kondisi pengendaraan. 

Berbagai perbandingan roda gigi dalam arah maju (forward) dan satu arah mundur 

(reverse) dibuat oleh unit roda gigi planet. Disain unit roda gigi planet meliputi 2 

susunan roda gigi planet (planetary gear set) berupa roda gigi matahari (sun gear), 

roda gigi pinion (pinion gear) yang dihubungkan oleh planetary carrier dan sebuah 

http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm
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roda gigi cincin (ring gear). Bagian-bagian roda gigi planet ditahan dengan alat 

penahan (holding device) agar tidak bergerak, alat-alat penahan ini dapat berupa 

kopling multiplat (multiplate clutches) atau rem-rem (brakes), pita rem (brake 

band) dan kopling-kopling satu arah (one way clutches). 

 

Gambar 2.5. Susunan roda gigi planet. 

(http://machinedesign.com/article/green-technology-jets-gear-up-to-fly-greener-0619) 

 

c. Sistem Kontrol Hidrolik (Hydraulic Control System)  

Operasi dari unit roda gigi planet dikontrol oleh sistem kontrol hidrolik. Tekanan 

hidrolik dan titik-titik perpindahan gigi (shift) juga diatur oleh sistem hidrolik 

berdasarkan kecepatan kendaraan dan posisi  throttle. Kopling-kopling dan  rem-

rem diatur oleh fluida yang mengalir karena tekanan dari pompa oli (oil pump)  

melalui valve body sehingga perbandingan putaran dari susunan roda gigi planet 

dapat dikontrol. 

 

Gambar 2.6. Sistem Control hidrolik. 

(http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm) 

 

http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm
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2.2 Unit Roda Gigi Planet (Planetary Gear Unit) 

Planetary gear unit terdiri dari beberapa planetary gear set dan beberapa clutches serta 

brakes, sebuah planetary gear set terdiri dari sebuah roda gigi matahari (sun gear), roda 

gigi pinion (pinion gear) yang dihubungkan oleh planetary carrier dan sebuah roda gigi 

cincin (ring gear). 

 

Gambar 2.7. Layout susunan roda gigi planet. 

(http://www.precisiontransmission.biz/HowTransWork.htm) 

 

Roda gigi matahari terletak di pusat, sementara roda gigi pinion berputar di sekelilingnya, 

dan sebuah roda gigi cincin di sekitar roda gigi pinion. Susunan roda gigi ini disebut roda 

gigi “planetary” karena roda gigi pinion nampak seperti planet-planet yang berputar di 

sekeliling matahari. 

Dalam sebuah disain roda gigi planet, didapat perbandingan roda gigi yang berbeda untuk 

gerakan maju (forward) dan gerakan mundur (reverse), meskipun poros-poros roda gigi 

terletak pada sumbu yang sama. 

Tabel 2.1. Cara kerja roda gigi planet sederhana. 

Tetap/diam 

(Fixed) 

Power 

Input 

Power 

Output 

Putaran 
Arah Putaran 

Kecepatan Torsi 

Ring Gear 
Sun Gear Carrier Turun Naik Sama dengan arah 

penggerak Carrier Sun Gear Naik Turun 

Sun Gear 
Ring Gear Carrier Turun Naik Sama dengan arah 

penggerak Carrier Ring Gear Naik Turun 

Carrier 
Sun Gear Ring Gear Turun Naik Berlawanan arah 

dengan penggerak Ring Gear Sun Gear Naik Turun 

 



xix 

 

Arah Maju (Forward Direction) 

Ketika roda gigi cincin atau roda gigi matahari dipegang/ditahan dalam sebuah posisi 

yang tetap, dan anggota-anggota yang lain  sebagai anggota input, arah putaran roda gigi 

output selalu sama dengan arah putaran roda gigi input. 

Ketika roda gigi cincin berputar searah jarum jam (clockwise), roda gigi pinion berjalan 

searah jarum jam di sekeliling roda gigi matahari yang diam. Akibatnya planetary carrier 

berputar pada kecepatan yang diperlambat (kecepatan turun). 

 

Gambar 2.8. Mekanisme reduksi pada susunan roda gigi planet. 

(Tri Istanto, 2007) 

 

Ketika planetary carrier berputar searah jarum jam (clockwise), roda gigi pinion 

menyebabkan roda gigi cincin berputar searah jarum jam dan dipercepat pada kecepatan 

yang lebih besar daripada kecepatan planetary carrier. 

 

Gambar 2.9. Mekanisme overdrive pada susunan roda gigi planet. 

(Tri Istanto, 2007) 
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Arah Mundur (Reverse Direction) 

Ketika planetary carrier diam dan roda gigi-roda gigi yang lain adalah sebagai input, 

roda gigi output akan berputar dalam arah berkebalikan. Dengan planetary carrier diam, 

ketika roda gigi matahari berputar searah jarum jam, roda gigi pinion idle dan roda gigi 

cincin digerakkan dalam arah berkebalikan (berlawanan arah jarum jam). 

 

Gambar 2.10. Mekanisme reverse (gigi mundur)  pada susunan roda gigi planet. 

(Tri Istanto, 2007) 

 

2.3 Alat-Alat Penahan (Holding Devices) Susunan Roda Gigi Planet 

Alat-alat penahan (Holding Devices) yang digunakan dalam susunan roda gigi planet 

ada tiga jenis, yaitu meliputi; kopling-kopling multiplat (multiplate clutches), pita rem 

(brake band), dan kopling-kopling satu arah (one way clutches). 

a. Kopling multiplat  menahan komponen planetary gear agar ikut berputar. 

b. Rem  menahan komponen planetary gear unit agar tidak berputar. 

1. Rem-rem multiplat (multiplate brakes) 

2. Pita rem (brake band) 

c. Roller atau Sprag One Way Clucthes  menahan komponen planetary gear dalam 

satu arah putaran. 

Kopling multiplat dan rem multiplat adalah yang paling biasa dipakai dari 3 jenis alat-

alat penahan, karena mempunyai banyak kegunaan dan fungsi. Pita rem (brake band) 

membutuhkan ruang yang sedikit dalam rumah  transmisi (transmission case) dan 

mempunyai luas permukaan yang lebar agar gaya penahan (holding force) besar/kuat. 

Kopling satu arah mempunyai ukuran yang kecil dan mudah untuk dilepas atau dipasang. 
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a. Kopling-kopling Multiplat (Multiplate Clucthes). 

Kopling-kopling multiplat menghubungkan dua komponen berputar dari susunan 

roda gigi planet. Planetary gear unit menggunakan beberapa kopling multiplat, yaitu 

kopling maju (forward clucth) (C1) dan kopling langsung (direct clucth) dan kopling 

mundur (reverse clucth) (C2). 

 

Gambar 2.11. Kopling multiplat (multiplate clucthes). 

(http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm) 

 

Susunan clucth yang berputar saat kendaraan berjalan. 

 

Gambar 2.12. Cara kerja kopling multiplat. 

(Tri Istanto, 2007) 

 

Piston mempunyai sebuah perapat (seal) pada diameter dalam dan pada diameter 

luarnya, dimana piston dicegah dari kebocoran fluida. Sebuah katup pengaman jenis 

bola (relief ball valve) ditempatkan di bodi piston dari kopling multiplat. Katup ini 

mempunyai fungsi yang penting dalam melepaskan tekanan fluida hidrolik. Ketika 

kopling terlepas, sedikit fluida masih berada di belakang piston. Karena teromol 

http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm
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berputar, gaya sentrifugal akan mendorong fluida ke sisi luar dari teromol, dimana akan 

mencoba kontak dengan kopling.  Tekanan ini tidak sepenuhnya menghubungkan 

kopling, tetapi dapat mengurangi ruang bebas (clearance) antar disc dan metal plates. 

Katup pengaman jenis bola didisain untuk melepaskan fluida setelah tekanan terlepas. 

Gaya sentrifugal menyebabkan bola bergerak menjauh dari dudukan katup (valve seat) 

dan fluida terlepas keluar. 

Karena rem multiplat tidak berputar, fenomena ini tidak terjadi. Pegas pembalik (return 

spring) mendorong fluida keluar dari silinder, dan rem bebas. Tekanan hidrolik 

menggerakkan piston dan pegas pembalik mengembalikan piston ke posisi istirahat 

(rest position) di dalam teromol kopling ketika tekanan dilepaskan. Cakram-cakram 

gesek (friction discs) adalah plat-plat baja yang dilekatkan dengan material gesek. 

Diameter dalam dari cakram diberi celah untuk memasukkan pasak dari hub kopling. 

b. Rem (Brake) 

Ada 2 jenis rem, yaitu : 

1. Jenis pita (brake band)  untuk rem luncur kedua (second coast brake) B1 

pada beberapa model transmisi. 

 

Gambar 2.13. pita rem (brake band). 

(http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm) 

 

Pita rem ditempatkan di luar sekitar dari teromol kopling langsung (direct 

clucth drum). Salah satu ujung pita rem ini diletakkan ke casing transmisi 

dengan sebuah pena (pin), sedangkan ujung yang lain melekat dengan piston 

rem (brake piston) dimana dioperasikan dengan tenaga hidrolik. 

 

 

 

http://www.turbodiy.com/Mopar%20Pages/Tranny%20upgrades%20detail.htm
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Cara Kerja Pita Rem 

 

Gambar 2.14. Cara Kerja Pita Rem. 

(Tri Istanto, 2007) 

 

Pada brake tipe brake band, brake band menjepit brake drum yang 

dihubungkan dengan anggota planetary gear set sehingga mencegah anggota 

untuk berputar. Ketika tekanan hidrolik dikenakan ke piston, piston bergerak ke 

kiri dalam silinder piston, menekan pegas bagian luar (outer spring). Pegas 

bagian dalam (inner spring) memindahkan gerakkan ke batang piston (piston 

rod), menggerakkan ke kiri dengan piston, dan menekan salah satu pita rem, 

mengurangi pertautan pita. Ketika pegas bagian dalam menekan, piston 

berhubungan langsung dengan bahu batang piston dan gaya gesek yang tinggi 

ditimbulkan antara pita rem dan teromol. Karena ujung yang lain dari pita rem 

tetap pada casing transmisi dan diameter pita berkurang. Pita rem mengklaim 

dengan keras teromol, memegang agar tidak dapat bergerak, dimana 

menyebabkan teromol dan susunan dari roda gigi planet dibuat tetap ke casing 

transmisi. Ketika fluida bertekanan dibuang dari silinder, piston dan batang 

piston didorong kembali oleh pegas sehingga teromol terbebas dari pita rem. 

2. Jenis multiplat  digunakan pada rem second coast brake pada beberapa model 

dan pada brake B2 & B3. 

Mempunyai fungsi yang sama seperti pita rem dan dibuat dengan cara yang 

sama dengan kopling multiplat. Rem multiplat mengunci atau menahan sebuah 

komponen putar dari susunan roda gigi planet ke casing transmisi. 
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Gambar 2.15. Rem Multiplat. 

(Tri Istanto, 2007) 

 

c. Kopling Satu Arah (One way Clucth) 

Sebuah alat pemegang/penahan yang tidak memerlukan perapat (seals) atau 

tekanan hidrolik. Kopling satu arah dapat berupa sebuah kopling rol (roller clucth) atau 

sprag clutch. Cara kerjanya hampir sama tergantung pada logam tipis (wedging metal) 

diantara dua saluran (race). Dua kopling satu arah digunakan dalam planetary gear 

unit. Kopling satu arah No.1 digunakan pada gigi kedua dan kopling satu arah No.2 

digunakan pada gigi pertama. 

 

Gambar 2.16. Kopling satu arah tipe sprag. 

(Tri Istanto, 2007) 
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Kopling satu arah tipe sprag terdiri dari sebuah hub sebagai saluran dalam (inner race) 

dan sebuah teromol sebagai saluran luar (outer race). Kedua saluran dipisahkan oleh 

sprag. 

Untuk membantu sprag dalam mendesak, dipasang sebuah pegas penahan (retainer 

spring), dimana menjaga sprag miring (beberapa derajat) pada setiap waktu dalam arah 

mengunci saluran putar. 

Kopling satu arah jenis rol (one-way roller clutch) terdiri dari sebuah hub, roller (rol), 

dan pegas-pegas yang dikelilingi oleh tromol bergerigi (cam cut drum). Ketika saluran 

dalam (inner race) berputar searah jarum jam, roller menekan pegas dan saluran di 

ijinkan untuk berputar. Jika saluran berputar dalam arah sebaliknya, gaya dari roller 

akan mengunci saluran. 

 

Gambar 2.17. Kopling satu arah tipe rol (one way roller clutch). 

(Tri Istanto, 2007) 
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Gambar 2.18. Kopling satu arah No.1 dan No.2. 

(Tri Istanto, 2007) 

 

Kopling satu arah No.1 (F1) bekerja dengan rem kedua (second brake) B2 mencegah 

roda gigi matahari berputar berlawanan arah jarum jam (counterclockwise). Kopling 

satu arah No.2 (F2) mencegah planetary carrier belakang berputar berlawanan arah 

jarum jam. 

 

2.4 Pemilihan Roda Gigi dan Fungsinya  

 

Gambar 2.19. Tuas Pemindah (shift lever). 

(http://rajufebrian.wordpress.com/2008/08/28/hppm-produksi-sejuta-transmisi-at/) 
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Tuas pemindah (shift lever) mempunyai 6 posisi untuk mengindikasi posisi roda gigi 

yang dipilih. Posisi-posisi roda gigi ini menentukan kombinasi yang berbeda dari holding 

devices. 

Gear Selector 

Positions 

▬ P 

▬ R 

▬ N 

▬ D 

▬ 2 

▬ L 

 

a. Park (P) 

Posisi roda gigi ini adalah sebuah bentuk keamanan dimana mengunci poros output 

ke rumah transmisi. Pengaruhnya adalah mengunci roda-roda penggerak, mencegah 

kendaraan bergerak maju ataupun mundur. Posisi ini seharusnya dipilih jika kendaraan 

tidak berhenti sempurna. Pada posisi park (P), mesin dapat dinyalakan dan dapat diuji 

unjuk kerjanya. 

 

Gambar 2.20. Posisi gigi park (P). 

(Tri Istanto, 2007) 

 

b. Reverse (R) 

Posisi gigi reverse mengijinkan kendaraan untuk bergerak mundur. Dapat 

digunakan untuk menguji tekanan pompa oli maksimum selama tes stall. Sebagai 

catatan mesin jangan di-start pada posisi ini. 
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Gambar 2.21. Posisi gigi reverse (R). 

(Tri Istanto, 2007) 

 

c. Neutral (N) 

Posisi gigi neutral ini mengijinkan kendaraan untuk di-start dan beroperasi tanpa 

menjalankan kendaraan. Kendaraan dapat digerakkan dengan atau tanpa mesin 

berputar. Mesin dapat di-start ulang (restart) ketika kendaraan sedang bergerak. 

 

Gambar 2.22. Posisi gigi neutral (N). 

(Tri Istanto, 2007) 

 

d. Manual Low (L) 

Posisi ini dapat dipilih pada sembarang kecepatan kendaraan, ini menyebabkan 

secara langsung transmisi berpindah ke gigi yang lebih rendah (downshift) masuk ke 

gigi pertama sampai mendekati kecepatan 29-39mph tergantung pada modelnya. 

Jangkauan gigi ini menyediakan untuk pengereman mesin maksimum dan mencegah 

kendaraan berpindah ke gigi yang lebih tinggi seperti gigi ketiga atau kedua. 
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Gambar 2.23. Posisi gigi manual low (L). 

(Tri Istanto, 2007) 

 

e. Manual Second (2) 

Posisi ini dapat dipilih pada sembarang kecepatan kendaraan dan akan downshift ke 

gigi kedua. Dalam beberapa seri transmisi tertentu dengan D-2 Downshift Timing 

valve, transmisi memindahkan gigi dari OverDrive (OD) ke gigi ketiga dan kemudian 

ke gigi kedua. Jangkauan roda gigi ini menyediakan pengereman mesin yang kuat dan 

mencegah kendaraan berpindah ke gigi yang lebih tinggi ke overdrive dan gigi ketiga. 

Tetapi ada pengecualian pada seri transmisi tertentu, pada kecepatan yang lebih tinggi, 

mendekati 64mph, kendaraan akan berpindah ke gigi ketiga ketika tuas dipilih ke 

manual second. 

 

Gambar 2.24. Posisi gigi manual second (2). 

(Tri Istanto, 2007) 

 

f. Drive (D) 

Pada posisi ini transmisi dalam keadaan otomatis penuh (full automatic), yaitu 

perpindahan roda gigi yang lebih besar (upshift) atau yang lebih kecil (downshift) 

berdasarkan pada kecepatan kendaraan dan beban pada mesin. Kenaikan beban 
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dirasakan melalui naiknya bukaan throttle, dan transmisi berpindah ke gigi yang lebih 

rendah (downshift). Dengan penurunan bukaan throttle, beban berkurang dan transmisi 

berpindah ke gigi yang lebih besar (upshift). Sebagai catatan mesin jangan di-start pada 

posisi gigi ini. 

 

Gambar 2.25. posisi gigi Drive (D). 

(Tri Istanto, 2007) 

 

2.5 Aliran Tenaga (Power Flow) 

a. Poros-poros Susunan Roda Gigi Planet 

Ada tiga poros dalam susunan roda gigi planet, yaitu : poros input, roda gigi 

matahari (sun gear) dan poros output. Poros input digerakkan dari turbin dalam torsi 

konverter. Poros input dihubungkan ke bagian depan roda gigi cincin planetary gear 

melalui kopling multiplat. Roda gigi matahari biasanya menghubungkan bagian depan 

(front planetary gear) dan bagian belakang susunan roda gigi planet (rear planetary 

gear), memindahkan torsi dari roda gigi planet ke bagian belakang susunan roda gigi 

planet. Poros output dipasak ke carrier dari bagian depan susunan roda gigi planet dan 

menyediakan torsi putar ke roda-roda belakang atau ke unit overdrive. 
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Gambar 2.26. poros-poros roda gigi planet. 

(Tri Istanto, 2007) 

 

b. Holding Devices 

Holding devices untuk susunan roda gigi planet dapat diidentifikasi di tabel  di 

bawah ini dengan komponen yang dikontrol sebagai berikut : 

Tabel 2.2. Holding Devices 

Holding Device Fungsi 

C1 Forward Clutch 
Menghubungkan/memutuskan input shaft dengan 

front ring gear. 

C2 Direct Clutch 
Menghubungkan/memutuskan input shaft dengan sun 

gear (bagian depan dan belakang). 

B1 2
nd

 Coast Brake 
Menahan/mengunci sun gear (bagian depan dan 

belakang) supaya tidak berputar. 

B2 2
nd

 Brake 

Menahan lintasan luar (outer race) one way clutch F1 

agar tidak berputar searah jarum jam maupun 

berlawanan jarum jam, sehingga mencegah bagian 

depan dan belakang sun gear berputar berlawanan 

arah jarum jam. 

B3 1
st
  dan Reverse Brake 

Mencegah rear planetary carrier agar tidak berputar 

searah jarum jam maupun berlawanan jarum jam. 

F1 One-way clutch 1 

Menahan bagian depan dan belakang sun gear agar 

tidak berputar berlawanan arah jarum jam. Ketika 

brake B2 bekerja. 

F2 One-way clutch 2 
Mencegah bagian rear planetary carrier berputar 

berlawanan arah jarum jam. 
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1
st
 dan reverse brake (B3) dan one-way clucth F2 mengatur planetary carrier bagian 

belakang secara paralel. Bersama-sama menyediakan sebuah gaya penahan yang besar 

pada planetary carrier untuk mencegahnya berputar selama gigi pertama. 

Second brake (B2) dan one-way clucth F1 mengatur roda gigi matahari secara seri. 

Sehingga mengijinkan roda gigi matahari berputar searah jarum jam hanya ketika B2 

digunakan/dipakai. 

Second coast brake (B1) menahan roda gigi matahari, mencegah berputar dalam arah 

manapun. Ini menyebabkan pengereman mesin ketika dalam jangkauan roda gigi 

kedua. 

 

Gambar 2.27. Planetary holding devices. 

(Tri Istanto, 2007) 

 

c. Tabel Penggunaan Kopling Tiga Kecepatan. 

Tabel mendiskripsikan holding device mana yang digunakan untuk setiap posisi 

roda gigi. Jika pada sisi sebelah kiri tabel, kolom posisi tuas pemindah (shift lever 

position) pada “D” dan pada posisi gigi pertama (1st gear position), kotak-kotak yang 

diberi warna abu-abu di sebelah kanan posisi roda gigi (gear position) menyatakan 

holding device yang digunakan dalam roda gigi pertama. Pada kolom atas dari kotak 

berwarna abu akan ditemukan kode untuk holding device, sebagai contoh pada posisi 

“D” gigi pertama (1st gear), forward clucth (Cl) dan No. 2 One way clucth (F2) 

digunakan untuk gigi pertama.  
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Tabel penggunaan kopling menunjukkan bahwa jika transmisi berpindah ke gigi 

yang lebih tinggi (upshjft) ke roda gigi berikutnya, sebuah holding device tambahan 

dipasangkan melalui kopling atau rem yang digunakan. Sebagai contoh, jika pada 

posisi “D” gigi pertama berpindah ke gigi kedua, B2 digunakan sementara Cl tetap 

digunakan dan ketika berpindah ke gigi ketiga, C2 digunakan sementara B2 dan Cl 

tetap digunakan. Kopling-kopling satu arah (one way clucthes) adalah holding device 

untuk membebaskan ketika sebuah perpindahan gigi ke yang lebih tinggi (upshift) 

terjadi, tetapi tetap siap digunakan secara otomatis ketika bagian yang berputar dalam 

arah berlawanan jarum jam. 

Tabel 2.3. Penggunaan kopling 3 kecepatan 

Shift Lever 

Position 
Gear Position Cl C2 B1 B2 B3 Fl F2 

p Parking        

R Reverse        

N Neutral        

 

D 

1
st
        

2
nd

        

3
rd

        

2 1
st
        

2
nd

        

L 1
st
        

2
nd*

        

*Down-shift in L range, 2nd gear only-no up-shift. 

  Indicates that holdng device is applied but not a funtion of the current gear position. 

 

Tabel penggunaan kopling adalah kunci dalam diagnosis. Ketika dalam transmisi 

terjadi malfunction (tidak berfungsi) dan diagnosa mengarahkan ke sebuah roda gigi 

tertentu berdasarkan referensi tabel ini untuk mengidentifikasi holding device mana 

yang rusak. 

 

d. Aliran Tenaga (Power Flow) Susunan Roda Gigi Planet. 

Setiap posisi tuas pemindah mengindikasikan kombinasi yang berbeda dari holding 

devices (clutch dan brake) yang digunakan dan menentukan posisi roda gigi yang 

dipilih, posisi-posisi roda gigi ini secara otomatis membuat kombinasi putaran yang 

berbeda pada planetary gear unit yang menyebabkan torsi dan kecepatan putar yang 
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berbeda antara input shaft dan output shaft. Berikut adalah tabel kombinasi holding 

devices yang digunakan untuk mempengaruhi arah putaran roda gigi pada planetary 

gear unit : 

Tabel 2.4. Kombinasi putaran Planetary Gear Unit. 

Shift Level 

Position 

Gear 

Position Holding Devices   

Planetary 

Depan 

Planetary 

Belakang 

D 1
st C1, F2 Sun Gear CCW CCW 

      Planetary Carrier CW DIAM 

      Ring Gear CW CW 

      Planetary gear CW CW 

  2
nd C1, B2 & F1 Sun Gear DIAM DIAM 

      Planetary Carrier CW CW (idle) 

      Ring Gear CW CW 

      Planetary gear CW CW 

  3
rd C1, C2, B2 Sun Gear CW CW 

      Planetary Carrier CW CW 

      Ring Gear CW CW 

      Planetary gear DIAM DIAM 

2 1
st C1, F2 Sun Gear CCW CCW 

      Planetary Carrier CW DIAM 

      Ring Gear CW CW 

      Planetary gear CW CW 

  2
nd C1, B1, B2, F1 Sun Gear DIAM DIAM 

      Planetary Carrier CW CW (idle) 

      Ring Gear CW CW 

      Planetary gear CW CW 

L 1
st C1, B3, F2 Sun Gear CCW CCW 

      Planetary Carrier CW DIAM 

      Ring Gear CW CW 

      Planetary gear CW CW 

R Reverse C2, B3 Sun Gear CW CW 

      Planetary Carrier CCW DIAM 

      Ring Gear CCW CCW 

      Planetary gear CCW CCW 

CW  : Clockwise (Searah jarum jam) 

CCW : Counterclockwise (Berlawanan Jarum Jam) 
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1. Gigi Pertama (First Gear). 

Gigi pertama menggunakan bagian depan dan bagian belakang susunan roda 

gigi planet, forward clucth (Cl) digunakan dalam semua gigi maju (forward) untuk 

menggerakkan roda gigi cincin dan susunan roda gigi planet. Ketika roda gigi 

cincin berputar searah jarum jam, menyebabkan pinion-pinion berputar searah 

jarum jam, karena roda gigi matahari tidak ditahan diam, roda gigi matahari 

berputar dalam arah berlawanan jarum jam. Bagian planetary carrier depan, 

dimana dihubungkan ke poros output, berputar, tetapi lebih lambat daripada roda 

gigi cincin, sehingga berfungsi sebagai unit penahan.  

Pada bagian belakang roda gigi planet, carrier dikunci ke casing oleh No. 2 one 

way clucth (F2). Torsi dipindahkan ke planetary bagian belakang oleh roda gigi 

matahari, dimana berputar berlawanan arah jarum jam. Dengan tahanan carrier, 

roda gigi-roda gigi pinion belakang berputar dalam arah searah jarum jam dan 

menyebabkan roda gigi cincin bagian belakang berputar searah jarum jam. Roda 

gigi cincin bagian belakang dihubungkan ke poros output dan memindahkan torsi 

ke roda-roda penggerak. 

 

Shift Lever 

Position 
Gear Position Cl C2 B1 B2 B3 Fl F2 

D 1
st
        

Gambar 2.28. Aliran tenaga gigi pertama set D. 

(Tri Istanto, 2007) 
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2. Gigi Kedua (Second Gear). 

Forward clucth (Cl) menghubungkan poros input ke bagian depan roda gigi 

cincin. Roda gigi matahari digerakkan dalam arah berlawanan arah jarum jam pada 

gigi pertama dan dengan menggunakan second brake (B2) roda gigi matahari 

dihentikan oleh No. 1 one way clucth (Fl) dan ditahan ke casing. Ketika roda gigi 

matahari ditahan diam, roda gigi-roda gigi pinion depan yang telah digerakkan oleh 

roda gigi cincin berjalan di sekitar roda gigi matahari dan carrier memutar poros 

output.  

Keuntungan dari No.2 one way clucth (F2) adalah dalam otomatisasi 

perpindahan gigi ke gigi yang lebih besar (upshift) dan perpindahan gigi ke gigi 

yang lebih rendab (downshift). Hanya satu kopling multiplat digunakan atau 

dibebaskan untuk mencapai upshift ke gigi kedua atau downshift ke gigi pertama.  

Second brake (B2) dan one way clutch (Fl) keduanya menahan roda gigi 

matahari secara seri. Second brake menahan lintasan luar (outer race) dari one way 

clucth ke casing transmisi ketika digunakan. One way clucth mencegah roda gigi 

matahari berputar berlawanan arah jarum jam hanya ketika second brake 

digunakan. 

 

Shift Lever 

Position 
Gear Position Cl C2 B1 B2 B3 Fl F2 

D 1
st
        

2
nd

        
Gambar 2.29. Aliran tenaga gigi kedua set D. 

(Tri Istanto, 2007) 
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3. Gigi Ketiga (Third Gear). 

Forward clucth (Cl) digunakan untuk semua gigi maju dan menghubungkan 

poros input ke roda gigi cincin bagian depan. Direct clucth (C2) menghubungkan 

poros input ke roda gigi matahari. Dengan menggunakan direct clucth dan forward 

clutch, maka roda gigi cincin dan roda gigi matahari terkunci melalui tromol direct 

clucth dan tromol input roda gigi matahari. Kapanpun kedua anggota susunan roda 

gigi planet ini terkunci bersama akan menghasilkan direct drive (gear ratio 1:1). 

Second brake (B2) juga digunakan pada gigi ketiga, karena No 1 one way 

clucth (F1) tidak menahan roda gigi matahari dalam arah searah jarum jam, second 

brake tidak mempunyai pengaruh dalam gigi ketiga. Second brake digunakan 

dalam gigi ketiga karena pada proses downshift ke gigi kedua, yang diperlukan 

adalah membebaskan direct clucth (C2). Roda gigi cincin menyediakan torsi input 

dan roda gigi matahari dibebaskan. Carrier dihubungkan ke poros output dan 

penggerak akhir sehingga poros output melambatkan carrier. Roda gigi-roda gigi 

pinion berputar searah jarum jam memutar roda gigi matahari berlawanan arah 

jarum jam sampai dihentikan oleh No 1 one way clucth. Carrier menyediakan 

output ke penggerak akhir (final drive).  

 

Shift Lever 

Position 
Gear Position Cl C2 B1 B2 B3 Fl F2 

 

D 

1
st
        

2
nd

        

3
rd

        
Gambar 2.30. Aliran tenaga gigi ketiga set D. 

(Tri Istanto, 2007) 
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4. Gigi Mundur (Reverse Gear). 

Direct clucth (C2) digunakan dalam gigi mundur, dimana menghubungkan 

poros input ke roda gigi matahari. First dan reverse brake (B3) juga digunakan, 

mengunci carrier belakang ke casing. Dengan carrier dalam posisi terkunci, roda 

gigi matahari berputar searah jarum jam menyebabkan roda gigi-roda gigi pinion 

berputar berlawanan arah jarum jam. Roda gigi-roda gigi pinion kemudian 

menggerakkan roda gigi cincin dan poros output berlawanan arah jarum jam.  

 

Shift Lever 

Position 
Gear Position Cl C2 B1 B2 B3 Fl F2 

P Parking        

R Reverse        
Gambar 2.31. Aliran tenaga gigi mundur. 

(Tri Istanto, 2007) 
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BAB III 

PEMBUATAN ANIMASI SISTEM TRANSMISI OTOMATIS 

 

3.1 Alur Pembuatan Animasi Sistem Transmisi Otomatis. 

 

Gambar 3.1. Diagram Alur Pembuatan Animasi Sistem Transmisi Otomatis. 
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3.2 Pembuatan Gambar 3D Planetary Gear Unit. 

a. Dimulai dari gambar roda gigi 2D yang dibuat dengan Vector Works 11 : 

 

Gambar 3.2. Bidang kerja Vector Works 11. 

 

1. Mengatur workspaces mechanical dengan cara klik menu bar File ► 

Workspaces ► Mechanical. 

2. Mengatur units drawing dengan cara klik menu bar Page ► Units, kemudian 

atur Unit Name dalam Millimeters. 

3. Untuk membuat gear klik kanan  kemudian pilih worm gear 

, letakkan 2D worm gear pada viewport dan atur 

Number of Teeth menjadi 24. 

4. Membuat sebuah gear dengan langkah yang sama tetapi ubah Number of Teeth 

menjadi 15. 
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Gambar 3.3. Roda gigi 2D hasil dari Vector Works 11. 

 

5. Export file dalam bentuk DWG (AutoCAD file) dengan cara klik File ► 

Exports ► Export DXF/DWG, klik OK. Mengatur format menjadi DWG dan 

version menjadi 2004, klik OK. Pilih lokasi, beri nama file dan tekan Save. 

b. Membuat gambar Planetary Gear dengan AutoCAD. 

1. Membuka program AutoCAD. 

2. Ubah drawing units dengan cara klik menu Format ► Units dan atur insertion 

scale dalam Millimeter. 

3. Membuka file gear 2D yang telah dibuat dengan cara klik menu File ► Open. 

4. Cut kedua object gear kemudian ubah view menjadi Left dan Paste untuk 

meletakkan object. 

 

Gambar 3.4. Hasil import pada AutoCAD. 
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5. Select pada kedua gear dan klik menu Modify ► Explode. Kemudian 

copy/hapus/ubah dan atur gear menjadi seperti dibawah ini 

 

Gambar 3.5. Susunan roda gigi. 

 

6. Membuat ring gear, copy sebuah gear dan atur menjadi seperti dibawah ini : 

 

Gambar 3.6. Membuat ring gear. 
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7. Hapus bagian yang tidak perlu dan sisakan hanya satu buah teeth dari gear 

tersebut. Copy teeth gear tersebut dengan menggunakan Polar Array sejumlah 

56 dengan titik pusat pada gear besar di tengah. 

 

  Gambar 3.7. Membuat ring gear. 

 

8. Membuat sebuah lingkaran dengan radius 150 mm. 

 

Gambar 3.8. Ring gear yang sudah jadi. 
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9. Membuat gambar dasar planetary gear unit 2D. 

 

Gambar 3.9. Gambar dasar Planetary Gear Unit. 

 

Dengan ketentuan sebagai berikut : 

 

Gambar 3.10. Gambar dasar bagian B2, B3, F1 dan F2. 
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Gambar 3.11. Gambar dasar Planetary Carrier depan dan belakang. 

 

 

Gambar 3.12. Gambar dasar bagian Clutch C1 dan C2. 
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10. Memutar bagian front planetary gear dan rear planetary gear sesuai dengan 

poros vertikalnya sehingga dalam pandangan isometric terlihat sebagai berikut : 

 

Gambar 3.13. Gambar dasar Planetary Gear Unit. 

 

c. Membuat bagian 3D pinion gear dan sun gear depan dan belakang dengan cara 

meng-extrude gambar 2D yang telah dibuat. Dengan langkah sebagai berikut : 

1. Select object 2D yang akan di-extrude. 

2. Klik tombol Extrude  dan isi ketebalan benda. 

 

Gambar 3.14. Gambar dasar Planetary Gear Unit yang akan di-extrude. 
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3. Atur susunan benda sebagai berikut dan memberi setiap benda sebuah layer 

sesuai dengan namanya. 

 

Gambar 3.15. Hasil dari perintah extrude. 

 

d. Membuat bagian output shaft, ring gear depan dan belakang dengan langkah yang 

sama. 

 

Gambar 3.16. Hasil dari perintah extrude. 
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e. Menghubungkan bagian depan dan belakang sun gear dengan sebuah poros dan 

membuat input shaft dengan cara meng-extrude object 2D-nya. 

 

Gambar 3.17. Hasil dari perintah extrude. 

 

f. Membuat  bagian brake B2, B3, piston B2, B3, one way clutch F1, F2 dan poros 

yang berhubungan dengan rear planetary carrier dengan cara me-revolve gambar 

2D yang telah dibuat. 

 

Gambar 3.18. Hasil dari perintah revolve. 
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g. Membuat brake B1 beserta piston. 

 

Gambar 3.19. Hasil dari perintah revolve. 

 

h. Membuat disc clutch C1 dan C2 dengan piston. 

 

 

Gambar 3.20. Hasil dari perintah revolve. 
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i. Membuat input C1 yang berhubungan dengan input shaft dan output C1 yang 

berhubungan dengan front ring gear. 

 

Gambar 3.21. Hasil dari perintah revolve. 

 

j. Membuat poros input C2 yang berhubungan dengan input shaft dan poros output 

C2. 

 

Gambar 3.22. Hasil dari perintah revolve. 
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k. Membuat poros yang menghubungkan poros sun gear dengan poros output dari 

clutch C2, dan membuat titik acuan 0,0 yang akan digunakan untuk proses 

selanjutnya. 

 

Gambar 3.23. Hasil dari perintah revolve dan membuat titik acuan (center). 

 

l. Memotong bagian yang utuh sebagai berikut dan memberi nama pada layer bagian 

–bagian tersebut dengan menambahkan kata “potongan” sebelum nama benda : 

 

Gambar 3.24. Hasil dari perintah subtract. 
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m. Membuat bagian utuh yang sebelumnya telah dibuat menjadi seperti di bawah ini 

dan memberi nama masing-masing benda pada layer dan simpan gambar ini dalam 

sebuah file. 

 

Gambar 3.25. Planetary Gear Unit 3D. 

 

n. Meng-export seluruh gambar pada layer dalam bentuk file 3D Studio dengan cara 

klik File ► Export, member nama dan ubah files of type menjadi 3D Studio dan 

klik Save kemudian pilih semua object dan klik OK. 
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